User guide
S. H. Roxburgh
2008

Table of contents
1. Introduction .......................................................................................................................... 4
2. The Digital Transferscope (TDT) overview ....................................................................... 6
2.1 Analysis overview........................................................................................................ 6
2.1.1 Analyses for photos taken at a single time ..................................................... 6
Single photo analysis (Figure 1a) .................................................................. 6
Mosaic analysis for overlapping photos (Figure 1b)..................................... 6
2.1.2 Analyses for changes through time................................................................. 7
Time series analysis for cover change (Figure 2a)........................................ 7
Single time-step mosaic analysis for cover change (Figure 2b) .................... 9
2.1.3 Time-series analysis constraints ..................................................................... 9
2.2 Data and hardware requirements ............................................................................... 9
2.2.1 Scanning aerial photographs........................................................................... 9
2.2.1 TDT required file type .................................................................................... 9
2.2.3 Minimum computer requirements ................................................................ 10
2.3 Software design & key algorithms ............................................................................ 10
2.3.1 Handling very large image files.................................................................... 10
2.3.2 Image rectification ........................................................................................ 11
2.3.3 Data sampling ............................................................................................... 13
2.4 Program interface and main components ................................................................. 15
2.4.1 Main form ..................................................................................................... 15
2.4.2 The Analysis Wizard .................................................................................... 17
2.4.3 Data entry form............................................................................................. 24
2.4.4 Data viewer form .......................................................................................... 27
2.4.5 Other program options.................................................................................. 29
3. Installation and distributed files ....................................................................................... 31
4. Tutorial – Time series analysis for cover change ............................................................ 31
5. References............................................................................................................................ 46

The Digital Transferscope (TDT) v. 1.0
Stephen H. Roxburgh
Contact details:
Bushfire CRC & School of Biological, Earth and Environmental Sciences,
The University of New South Wales. Sydney 2052 Australia.
Postal address:
c/- CSIRO Sustainable Ecosystems, PO Box 284, ACT 2911, Australia. Email:
stephen.roxburgh@csiro.au.

3

1. Introduction
The analysis of aerial photographs has a long history in environmental management,
particularly for vegetation assessment and mapping. Aerial photography also provides a link
between the small-scale analysis of vegetation, for example at the level of the individual
plant, and the functioning of entire landscapes. Aerial photographs are unique in providing
images of a high resolution (typically allowing the identification of objects at sub-metre
scales), spanning spatial extents ranging from a few square metres to 10’s of km2, and often
with photographic records extending over many decades, thus allowing long-term changes in
vegetation and land cover to be assessed.
The degree of processing required before aerial photographs can be used depends upon the
types of data required, and their accuracy. For vegetation mapping, or other purposes
requiring knowledge of the precise geographic locations of features within the photographs,
ortho-photographic rectification is a requirement. This involves transforming the photograph
in a number of ways to match an existing coordinate system. This typically involves
processing the images to correct for errors induced by e.g. camera lens distortion, earth
curvature, atmospheric refraction, camera tilt, and the use of Digital Elevation Models
(DEM’s) to correct for the effects of parallax caused by terrain relief (Wolf 1983). Orthophotographic rectification is an expensive and time-consuming exercise, and is therefore
usually limited to those studies that require the precise georeferenced mapping of vegetation
or other landscape elements.
In contrast, a number of researchers have developed simpler, more cost-effective methods to
extract coarser level information from aerial photographs, without the need for full orthorectification (e.g. Null 1969; Fensham & Fairfax 2002; McDougall 2003). These methods are
usually based on statistically sub-sampling the image, for example through overlaying grids of
points, to yield estimates of cover for different vegetation types or other groundcover classes.
This method of data collection is analogous to an ecological field survey, for example the
establishment of line transects, permanent quadrats, or other types of field-sampling
frameworks. The advantage of this approach is that, providing the array of sampling points is
set up with care (e.g. to avoid problems of spatial autocorrelation and other sources of nonindependence among the sampling points), then standard statistical analyses can be applied
(Fensham & Fairfax 2002). A major disadvantage is that these methods do not allow
continuous mapping of attributes e.g. vegetation polygons, but rather they provide an overall
estimate of cover within a defined area. A second disadvantage is that errors associated with
e.g. parallax and camera tilt remain unaccounted for. The potential bias induced by such
distortions should therefore be assessed against the accuracy required, the magnitude of the
changes being observed, and the characteristics of the vegetation being sample (Fensham &
Fairfax 2002).
Examples of these sample-based approaches include the overlaying onto printed photographs
a transparent film with printed sampling reticules, and then sampling manually with a
magnifying stereoscope (Fensham et al. 2002), and co-projecting onto a screen both the
photographic images and a transparent sampling grid (McDougall 2003). In this latter
example McDougall (2003) used a Bausch and Lomb transferscope to mechanically zoom,
stretch and tilt a photograph taken in one year to match one taken 44 years previously, thus
allowing the change in cover over the time period to be assessed.
The Digital Transferscope (TDT) software described here combines and extends the
sampling-based methodologies described above. In particular, it provides a software-based
analogue to the mechanical zoom transferscope, whereby scanned images are digitally
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rectified relative to one another by e.g. zooming, stretching, and tilting. The major advantages
of a digital solution to the mechanical transferscope are (a) the image rectification process can
be automated by combining standard image analysis and transformation algorithms with
function minimization techniques (see 2.3.2 below), and (b) the rectification process is
combined with the ability within the software to overlay an appropriate sampling grid, and for
the software to automatically locate and display (at a chosen level of magnification) the
sampling locations, facilitating the rapid collection of data.
The specifications for the software are listed below. In particular, the software was designed
to:
•
•

•

•
•
•
•
•

•

•
•

Input scanned aerial photographs of a high resolution, and therefore of a large file size
(typically greater than 300MB each).
Provide an interface allowing the simultaneous display of multi-scaled (i.e. multi-zoomed)
sub-images of a photo, allowing the simultaneous viewing of both large- and small-scale
features within the same photo.
Allow the user to locate control points on one of the photos (the reference photo), and also
be able to locate the same control points on either neighbouring or overlapping photos
within the same analysis (the target photo(s)).
Using these control points, mathematically transform the target photos (through either an
Affine or Projective transformation, see 2.3.2 below) to coincide with the reference photo.
Quantify statistically the error associated with these transformations
Allow the user to define a set of appropriate cover categories.
Allow the overlaying of a flexible sampling grid (i.e. a grid able to be resized, rescaled,
repositioned and rotated).
Allow data to be collected relative to this sampling grid, either as sampling points located
on this regular grid, or at random locations within the grid (see 2.3.3 below for a discussion
of the full sampling options).
Provide a flexible interface to allow the user to visually identify the cover class at a given
point, and to quickly and efficiently enter the data for that point and move on to the next,
including allowing the computer to automatically locate and display the next sample point.
View saved data, either graphically or in tabular form.
Export saved data in raw (text) format for import into other analysis packages, e.g.
Microsoft Excel.

An early attempt at a digital transferscope was given by Derenyi (1996), who described a set
of analyses conducted within proprietary GIS software for rectifying vector-based objects to
an existing reference photo. The Digital Transferscope described here differs in a number of
fundamental ways from that described in Deryani (1996). First, TDT is concerned with the
rectification of one or more photographic images, rather than a set of vector objects. Second, a
major functionality of TDT is the ability to define an appropriate sampling grid, and the
integrated software-assisted collection of the data. Finally, TDT is designed to be run standalone, without the need for any other additional software programs.
It should be stressed that, although it is possible to acquire scanned aerial photographs
relatively cheaply and easily at very high resolutions, in many instances traditional 3-D
stereoscopic viewing can provide valuable additional information on canopy structure and
topographic relief, for example separating tree and shrub canopies. For those projects where
3-D visualization is likely to significantly improve the differentiation of different land cover
categories, it is strongly recommended that the computer-based analyses described here are
augmented with stereoscopic validation using the original imagery.
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2. The Digital Transferscope (TDT) overview
The Digital Transferscope combines algorithms from Geographic Information Systems (GIS),
photographic/image analysis, and ecological field survey. The overall aim of the software is to
(i) provide an environment within which one or more scanned aerial photographs can be
rectified/transformed/warped to a reference photograph, through combining user-defined
control points with an automated optimization and fitting routine; (ii) provide an environment
within which sampling grids of various dimensions can be superimposed over the rectified
images, and (iii) allow the user to, with the aid of the software, identify and record the
appropriate cover class at each sampling location. In TDT the cover class records are entered
manually by the user, either by keyboard or mouse. For a detailed discussion of the merits of
manual/human cover determination over automated (algorithmic) procedures, see Fensham &
Fairfax (2002).
Within this broad framework a number of different analysis options are possible, and these are
described in section 2.1 below. Section 2.2 provides an overview of the data required for
analysis, including a technical description of the required input files. Section 2.3 describes
some of the key algorithms used in the software, and section 2.4 describes the software
interface and its operation.
2.1 Analysis overview
The Digital Transferscope has the capacity to conduct four types of analysis, classified below
into two main groups. The first group (section 2.1.1) are for the analysis of photographs taken
at a single time. The second group of analyses are for quantifying the change in cover through
time (section 2.1.2).
2.1.1 Analyses for photos taken at a single time
Single photo analysis (Figure 1a)
Although TDT was developed with time-series analyses in mind, it can also be used for
estimating vegetation cover at a single time. The Single photo analysis is the simplest option,
where cover estimates for a range of user-defined cover classes are extracted from a single
image (Figure 1a). It is akin to placing a transparent sampling grid over a physical image, and
then recording vegetation cover at sampling locations within that grid (see e.g. Fensham et al.
2002). Because only a single photo is used, the analysis does not require the establishment of
control points, nor any image rectification. As noted above, for all analyses data collection is
manual, in that the user must visually determine the correct cover class at each sampling
point.
Mosaic analysis for overlapping photos (Figure 1b)
The Mosaic analysis for overlapping photos analysis is used when the feature of interest
spans two or more photographs. In this case one photograph is chosen to be the reference
photo, and the remaining photographs (the target photos) are transformed or ‘rectified’ to the
reference photo (Figure 1b). Rectification is achieved by manually selecting pairs of control
points (CP’s) that are common to the reference photo and each target photo, and then applying
a set of algorithms to automatically search for the mathematical transformation that results in
the closest match between the (transformed) target photo control points and the reference
photo control points. These transformations typically involve scaling, rotating and stretching
the target image. The procedures for image rectification and the algorithms used are described
in section 2.3.2.
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(a) Single photo analysis

Cover estimates
for each cover
category
Sampling grid
overlay, and data
collection

(b) Mosaic analysis for overlapping photos
Photo A
A
R

Cover
estimates
B

Reference
photo (R)
Photo B

Photo rectification (A & B
transformed relative to
reference photo via userdefined control points)

Sampling grid overlay,
and data collection

Figure 1. Diagrams illustrating the analysis of cover from aerial photographs all taken at the same date (a) A
simple, single-photo analysis. (b) An image mosaic, required when the feature of interest occurs at the edge of
two or more aerial photographs. See text for further details.

2.1.2 Analyses of changes through time
The second class of analyses are designed to quantify changes in cover through time, and
therefore require an historical series of aerial photographs, i.e. spanning at least one time
interval. The analysis can be visualized as first aligning and then stacking a time-series of
photographs on top of one another, and then ‘drilling’ down through the stack at a number of
locations, and recording the cover category at each time and location.
Time series analysis for cover change (Figure 2a)
This analysis is appropriate when the area to be sampled occurs wholly within the bounds of
all photographs in the series. One of the photos in the series is designated the reference photo
(usually the earliest photo taken), and the subsequent photos are the target photos. First, each
target photo is rectified to the reference photo, then the sampling grid is created, and then
finally the cover data for each photograph (i.e. date) is collected.
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(a) Time series analysis for cover change
Time t photo
(Reference photo)

Sampling grid overlay,
and data collection

Time t+1 photo
Cover
estimates at
times t, t+1,
t+2, … t+n
Photo rectification (relative
to reference photo)

Sampling grid overlay,
and data collection

Photo rectification (relative
to reference photo)

Sampling grid overlay,
and data collection

Time t+n photo

(b) Single time-step mosaic analysis for cover change
Time t photo
(Reference photo)

Sampling grid overlay,
and data collection

Cover
estimates at
times t and t+1

Time t+1 photos

Photo rectification (relative
to reference photo)

Sampling grid overlay,
and data collection

Figure 2. Diagrams illustrating the analysis of cover change from an historical time-series of aerial photographs
(a) A multi-period analysis where the area of interest is fully enclosed within each photograph of the series (i.e.
no mosaicing of multiple images taken at the same date is required). The number of photos (i.e. dates) able to be
stacked is limited only by available computer memory (b) A single time-step mosaic analysis, required when the
area of interest for at least one of the time periods spans two or more aerial photographs. Because of the
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complexity of creating mosaicked images this analysis type is limited to a single time-step (i.e. the reference
photo at time t, and the n-photo mosaic of photos taken at time t+1). See text for further details.

Single time-step mosaic analysis for cover change (Figure 2b)
If the area to be sampled in any of the target photos spans more than one photograph, then the
single time-step mosaic analysis must be used. In this analysis a single photo at time t1 is
defined as the reference, and the photographs at time t2 are rectified into a mosaic. The cover
estimates for both time t1 and t2 are then determined. This single time-step constraint of this
analysis is discussed further in the next section.
2.1.3 Time-series analysis constraints
There are two main constraints in TDT when analyzing for cover changes through time.
First, the reference photo must be a single image; it cannot be created within TDT from a
mosaic of adjacent photographs as e.g. for the target photographs in Figure 1b. This is a
constraint imposed by the image transformation algorithms, by the physical memory available
in most desktop computers, and by the large file size (in Mb) of high-resolution scanned aerial
photographs.
Second, when a mosaic is required for a particular date within a time-series for one of the
target dates, then the analysis is limited to the single time-step spanning the period between
the mosaic and the reference photo (Figure 2b). This is again a limitation imposed by memory
availability, but also the practicalities of keeping track of multi-time and multi-mosaiced
images within the same project. This limitation can be overcome by splitting the analysis
across multiple project files, with each project sharing the same reference photo. To facilitate
this, TDT has an option for importing previously saved reference photo data (sampling grid
and saved cover data) into new projects. See 2.4.2 below.
2.2 Data and hardware requirements
2.2.1 Scanning aerial photographs
The choice of scanner for capturing images depends upon the quality of the scan required, the
quality and format of the original images (e.g. print vs. transparency), and budget. We have
obtained satisfactory results using a relatively cheap commercially available flatbed scanner
(Canon LIDE 600f), and scanning print images at the maximum resolution of 1200 d.p.i.
Higher resolution flatbed scanners are commercially available, as are a range of scanning
services.
When assessing scanners there are two main attributes to check. First, a trial image should be
scanned at the desired resolution, and the resulting file check at the highest magnification in
image editing software for the absence of blockiness and other artifacts that can result from
the scanning and image processing algorithms. Second, scanning a regular grid is
recommended, e.g. lined graph paper, to check for an absence of distortion.
2.2.1 TDT required file type
TDT requires all photo images to be in the device-independent bitmap (*.BMP) image format.
Existing images in other formats, e.g. *.JPG, *.TIFF therefore first need to be converted to
bitmap. The bitmap format offers a number of computational advantages. First, and most
importantly, it is uncompressed, which means TDT can access portions of the image directly
from diskfile, without having to load the entire image into memory; an important
consideration when each photo is typically in excess of 100Mb, and often much more.
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Second, bitmap files can be saved in a wide range of colour depths, from simple 1-bit (2
colours) through to 24-bit (16777216 colours). Finally, the bitmap is the native graphics
format for the Windows operating system, allowing the computer programming of image
manipulations such as file read/write and display to be streamlined.
The choice of colour depth is open to the user to decide. For colour images we use 24-bit, and
8-bit for grayscale. For a typical air photo print of 20cm x 20cm this corresponds to a scanned
file size of 250Mb for the colour image, and 90Mb for the grayscale (both scanned at 1200
d.p.i).
2.2.3 Minimum computer requirements
TDT runs under the Microsoft Windows operating system, version XP and above. A
minimum of 500Mb RAM is recommended, but 1Gb is preferable. Hard disk storage depends
upon the number of photographs to be analysed, but allow 100-300Mb for each photograph,
depending upon photograph dimensions, scanning resolution, and scanned colour depth.
2.3 Software design & key algorithms
TDT is coded in Borland Developer Studio 8.0 (Borland Delphi).
2.3.1 Handling very large image files
The biggest computational challenge for the analysis of scanned aerial photographs is how to
handle the inherently large files. This is an issue because image analysis and manipulation
require viewing the image on the screen, and this traditionally first requires loading the whole
image or images into computer memory. This can be problematic. For example the analysis in
figure 2b includes four photographs. Assuming a file size of 250Mb each, then in total this
analysis would require 1Gb of available RAM if all photographs were simultaneously loaded
into computer memory. On most standard computer systems this would quickly result in a
dramatic reduction in processing speed, usually rendering the computer inoperable.
To overcome this problem two solutions were employed. First, as a TDT project is loaded, the
original high resolution images are scanned from disk file on a line-by-line basis, and a lower
resolution index image is created; this lower-resolution copy is then stored in memory. These
index images are usually around 10Mb in size (c.f. 100-300Mb for the originals), thus
allowing all index images for all photographs in the analysis to be simultaneously stored in
memory. The algorithm GetDIBInBands (Sanchez 2003) was modified to perform this
rescaling. These index images are used to provide a low resolution overview or ‘roadmap’ of
the entire photograph, as explained below under ‘2.4.1 Main form’
Second, for viewing the high-resolution original photograph, only that portion of the
photograph currently being viewed in the zoom windows is loaded from disk file and
displayed. This works because, for interpretation and analysis, we usually only ever need to
view a subset of the total image, and accessing this sub-image directly from disk file again
avoids the necessity of having to load the entire high-resolution image into memory in one go.
A further modification of GetDIBInBands was used to read sub-areas from the disk-file
image.
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2.3.2 Image rectification
An overview of the image rectification procedure is shown in Figure 3. There are two main
algorithms. The first is the transformation method used to align the photos. The second is the
optimisation method used to automatically search for and set the transformation parameters
that provide the ‘best’ overlap between the reference are target photos. The overall procedure
is to first apply the optimisation algorithm to the set of control points to define the
transformation parameters, and then to apply the resulting transformation to the photographic
images as a whole.
(a) Reference photo
(1944)

(c) Rectified composite

(b) Target photo
(1968)

+



Figure 3. Summary of the rectification process. In this example 5 control points are located on the 1944
reference photo (the white circles in (a)), and the same 5 locations are identified on the target photo taken 24
years later, in 1968 (the white donuts in (b)). The rectification procedure automatically searches for the
transformation that best coincides the two sets of control points (c). In this case the transformation requires the
target photo to be enlarged, rotated clockwise, and skewed slightly.

Transformation algorithms
In TDT the user has the choice of two commonly used transformation methods to ‘warp’ and
‘rescale’ one image so it overlaps with another. The first is the AFFINE transformation,
which is itself a subset of the more general PROJECTIVE transformation (Wolf 1983).
The Affine transformation combines 4 distinct sub-transformations – transform, scale, rotate
and skew. The projective transformation includes the affine as a subset, by allowing the
arbitrary relocation in 2-dimensional space the four corners of the photograph. Example
transformations for each of these are shown in Figure 4.
In TDT, control point and image transformations were carried out using algorithms from the
Graphics32 library (Denisov 2007). Specifically, the classes
TAffineTransformation and TProjectiveTransformation.
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(a) Affine transformation components
(i)

(ii)

Translate

Stretch

(iv)

(iii)

Skew

Rotate

(b) Affine transformation (combined translate + stretch + rotate + skew)

(c) Projective transformation (arbitrary re-location of each corner of the photo)

Figure 4. Summary of the transformations methods. (a,b) The affine transformation comprises a combination of
four distinct sub-transformation; (i) translate, (ii) stretch; (iii) rotate; (iv) skew. (c) The projective transformation
arbitrarily re-locates the four corners of the image in 2-dimensional space.

Optimisation algorithm
The optimisation procedure involves iteratively transforming the target photo control points
until they overlap as closely as possible with the reference photo points. To test the degree of
overlap the Root Mean Square Error (RMSE) of the rectification is calculated:

RMSE =

[

1 n
(t x,i − rx,i )2 + (t y ,i − ry,i )2
∑
n i=1

]

where tx,i is the x-coordinate of control point i for the target photo (in pixels), rx,i is the xcoordinate of control point i for the reference photo, ty,i is the y-coordinate of control point i
for the target photo and ry,i is the y-coordinate of control point i for the reference photo. The
optimal overlap was found by minimizing the RMSE through transforming the target control
points, by either AFFINE or PROJECTIVE, using the downhill simplex search algorithm of
Nelder & Mead (Press et al. 1986). At the completion of the optimisation the simplex
algorithm returns the transformation parameters that yield the overall smallest distance (in
pixels) among the pairs of reference and target control points. Those same transformation
parameters were then applied to the full photographic image. This last step also requires
subsequent resampling (i.e. redrawing) of the photo to minimize artefacts that can occur when
digital photographic images are re-sized and re-shaped. Photo resampling was achieved using
the Graphics32 library’s TBitmap32Resampler class, using a linear resampling
kernel. The user also has the choice of a number of other more sophisticated resampling
kernels (e.g. cubic polynimial, Mitchell, B-Spline, Lanczos, Hermite), though our experience
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has shown the default linear resampling kernel provides a good balance between re-sampled
image quality and computational speed.
2.3.3 Data sampling
A key element of TDT is the ability to overlay an appropriate sampling grid, and to allow the
user to interactively enter cover categories at specified locations within the image.
Sampling grid
The overall concept is to define a rectangular sample area (subdivided into a number of square
grid cells) and then to sample within that area. The position of the sample area within the
photo, the sample area size, the number of grid cells (i.e. the resolution), and the orientation
are all user-definable (Figure 5).

Figure 5. Example sample areas.

Two types of data can be recorded. The first is to record the dominant cover type within each
grid cell, and the second is to record the cover at a points located within the grid cells. These
points can be either arranged on a regular lattice, or located at random within the grid cell.
This latter option corresponds to a restricted random array of sampling points. These various
options are illustrated in figure 6.

Figure 6. Illustration of the two point-based sampling strategies, where the user enters the cover category located
at a number of points (the red crosses) in the landscape. On the left hand side the points are located on a regular
lattice. On the right hand side each point is located at random within a grid cell. This point-based sampling can
also be augmented with a record of the dominant cover type within each grid cell.

There are two data collection methods. The first is automatic, where TDT locates each
sampling location, displays it on the screen, then waits for the user to enter the appropriate
cover category. Once the cover class is entered, the next sampling location is displayed, and
so on. The second method is manual, whereby the user clicks on any cell, and enters the
appropriate data. In manual mode contiguous areas of the same cover classification can also
be batch-selected (or ‘painted’), allowing large homogeneous areas to be quickly recorded.

13

An example TDT output is shown in Figure 7.

Figure 7. Example output map from TDT. For this project both point cover and grid cell dominance data were
collected, for two cover categories (tree [red] and grassland/wetland [green]). Grid cell dimensions were 30m x
30m. For this example 1281 random points were sampled, with an estimated tree cover of 62%, and
grassland/wetland cover of 38%.
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2.4 Program interface and main components
This section gives an overview of the main components of the program. The tutorial at the end
of this document provides a more in depth coverage of how these components work together.
2.4.1 Main form

The main project form is shown above. The two arrows mark the current location of the
cursor on the re-sampled low resolution index image of the photo, and the two zoom panels
on the right show successive magnifications of that location (with these sub-images read from
the full resolution photo on disk). The degree of zoom for each of these panels is adjustable,
and up to three zoom panels can be displayed. This interface provides a convenient way of
quickly inspecting fine details within large photos (or any other large bitmap images). The
tabs beneath the index photo provide access to each of the photos in the current project. In this
example there are four photos, with the ‘Reference photo’ currently displayed. The remaining
elements on the form are described below:
Main controls

This toolbar provides access to the major functions. The zoom and rotate options allow the
index photos to be zoomed (at any time) and rotated (prior to rectification only). The
‘Analysis wizard’ button brings up the step-by-step wizard for creating a project (see below).
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The ‘Start sampling’ button initializes the data sampling functionality (also see below), and
‘Close’ terminates the application.
Status bar

The status bar shows the x- and y- location (in pixels) of the cursor, and also shows total and
available system resources.
Main Menu

There are four Main menu items:
File:

‘New project’ resets the program ready for creating a new project. ‘Open existing project…’
brings up a standard ‘Open file’ dialog box where a previously saved project can be selected
and opened. ‘Reopen’ provides a short-cut list of up to the 10 most recently opened projects.
‘Save project’, ‘Save project As…’, and ‘Exit’ operate as in a standard Windows application.
Tools:

‘Analysis wizard’ initializes the Analysis wizard for creating and editing a project (see 2.4.2
below). ‘Results viewer’ brings up a form for displaying the saved data for the current project
(see 2.4.4 below) and ‘Program settings’ provides access to some underlying program options
(see below under 2.4.5).
View:

The ‘Control points’, ‘Sampling grid’, and ‘Sampling points’ items toggle the display of these
elements on the index photo. The ‘Current project file..’ displays the contents of the *.TDT
file for the current project. This is a text file that contains all of the information to load and
display a project, including drive and path locations of the photo files, control point
coordinates, affine and projective transformation parameters, etc. The ‘Copy current index
photo to clipboard’ copies the currently selected photo to clipboard.
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Help:
At present this just displays the about box, but in the future will also display the contents of
this help file.
2.4.2 The Analysis Wizard
Clicking the ‘Analysis wizard’ button on the main form, or from the tools menu, will open the
analysis wizard. This form has four numbered tabs, and it is designed to guide the user in
setting up a new project. The four tabs in order are: (1) Add photos to project; (2) Set control
points; (3) Rectify photos; and (4) Set up sampling grid.
Tab 1: Add photos to project

A new project begins by selecting the analysis type (either Single photo, Mosaic, Time series,
or Time-step mosaic; as described in section 2.1 above), and selecting the photos for analysis.
Clicking on the buttons allows individual photos to be added or deleted. Photos are added
through a standard Windows ‘Open file’ dialog box, and once selected a thumbnail and
filename of each photo is displayed in the appropriate panel, as shown above.
Tab 2: Set control points.

On this tab can be found the current list of control points, including their x- and y- locations
on the reference and target photos (the procedure for adding control points is described fully
in the tutorial). If a control point cannot be located on one of the target photos (e.g. it is
17

obscured, or is off the edge of the photo) a null coordinate for that photo can be selected
instead, and that control point is excluded in the rectification for that photo pair. The large
blank area is used during the control-point setting procedure, and is a display buffer showing
the location of the currently active control point on the reference photo.
Tab 3: Rectify photos.

Once the control points are set then each of the target photos can be rectified to the reference
photo. The transformation method (affine or projective) can be selected from the pull-down
menu. Pressing the ‘Rectify all photos’ button will start the optimisation. On completion, the
rectified images will be displayed on the viewing panels, and a statistical summary of the
rectification for each reference photo/target photo pair given in the spreadsheet. This
summary includes the transformation method that was used, the number of control points, and
the Root Mean Squared Error (RMSE) of the optimal fit, in pixels.
Also shown in the summary is the 3 x 3 transformation matrix that yielded the optimal fit, the
coordinates of each control point for the reference photo, and the coordinates on the target
photo following transformation (currently out of view in the example above).
Tab 4: Set up sampling grid.
The sampling grid can be defined in two ways. In the first an existing sampling grid can be
imported from a previously saved project that shares the same reference photograph, and
includes any cover data that might exist for that reference photograph. The second method is
to create a new sampling grid for the project.
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(a) Import sampling grid from existing project.

To import a sampling grid from a previously saved project, click the button on the form to
open the ‘file import’ interface:

Navigate to a directory containing previously saved *.TDT project files. Any projects that
share the same reference photograph as the current project will appear in the right-hand panel.
Select the project you wish to import from, and click ‘OK’.
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(b) Create new sampling grid.

This tab has two main sub-areas ‘Sample grid setup’ and ‘Data entry options’. The following
order is suggested for setting up a new sampling grid.
1. Define the cover class categories.
The small embedded spreadsheet in the ‘Date entry options’ area displays the currently
defined cover classes for the project. The default classes are ‘Tree’, ‘Grass’, ‘Shrub’ and
‘Unknown’. These can be customized by either adding a new cover class, editing an existing
cover class (e.g. changing the description, colour or shortcut key assignment), or deleting a
cover class. For example, to add a new ‘Wetland’ cover class, click on ‘Add cover class’:

Enter ‘Wetland’ in the description, and choose a colour and keyboard shortcut. This results in
an updated cover class list:
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2. Define the sampling scheme.
As described in section 2.3.3 there are three main sampling strategies. Cover can be entered
either at a point within the grid cell (i.e. the cover category of a single pixel is recorded), or as
a visual estimation of the dominant cover within the grid cell, or both (e.g. Figure 6). When
point sampling is selected, the points can either be located within the grid cells at random, or
at the grid centre (Figure 5). When a time-series analysis is performed and points are located
at random, there is additionally the option of retaining the same sampling locations through
time (‘Constant sample point locations’ = checked), or of generating a new set of random
locations for each time in the series (‘Constant sample point locations’ = unchecked). The
former results in a repeated-measures type analysis, whereas the latter provides independent
sampling locations through time. Goodall (1952) recommends retaining the same sampling
locations through time.
3. Define the sampling area.
When setting up a new grid the user has the option of defining the grid units as either pixels
(based on the reference photo) or metres. Metres are preferred, as they provides an intuitive
‘real life’ interpretation to the sampling design; but it does require having knowledge of the
actual dimensions of the scanned photograph. In the example project above it was determined
from independent measurements that one pixel in the reference photo was equal to 43 cm x 43
cm.
The order in which the dimensions and location of the sampling grid is defined is not
important, but we have found the following procedure to work relatively smoothly.
•
•

First define the size of the grid cells. In the above example they are set to 50m x 50m.
Then press the ‘Create new sampling grid’ button. This will generate a sampling grid that
covers the entire photo, as below:
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•

If the target area for study is a sub-area of the photo, then zoom (using the slider) and
drag (by clicking on the index photo and dragging) to position the target area in the centre
of the view, e.g.:

•

To isolate the target study area press the ‘Select sub area for analysis button’. The button
will turn yellow, and you can now select the range of grid cells by painting directly on the
index photo.
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•

On releasing the mouse you will be prompted to either accept the selection, to retry, or to
abort. Note that the dimensions of the current selection (the dimensions of the sample
area in metres, and also in grid cells) are updated on the Analysis Wizard form. In the
example below the sample area is 750m x 700m, corresponding to 15 x 14 grid cells
(each 50m x 50m). After clicking ‘Yes’ to accept the re-defined sample area, it can then
be nudged left-right and up-down, and rotated. The final sample area for this example,
after some rotation and nudging, is:

The project is now ready to sample.
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2.4.3 Data entry form
Clicking on the ‘Start photo sampling’ initializes the interface for collecting data:

The sampling form in the above screen-shot provides some instruction to assist with the
collection of the cover data. On first opening the form it prompts the user to select the
sampling mode; either manual or automatic. Clicking automatic will automatically select and
display the first sampling location within the zoom windows:
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Note that the current cell being sampled is coloured blue on the index photo. Because this
project is set to just record cover at random points within each grid cell, the instruction on the
sampling form is ‘Click on the cover for the selected point(s)’. The cell appears to be filled
with grassland, therefore clicking the green ‘Grass’ cover button (or clicking the ‘Grass’
shortcut key (F2 in this case) will record grass cover for this point, and the next sampling cell
will be automatically displayed. Note that the cross on the index photo for this cell has been
replaced with a colour-coded dot for the ‘Grass’ cover type, indicating data for this cell has
been collected. The next sampling point is automatically located and displayed:

Sampling automatically continues in this way, on a row-by-row basis:
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To sample manually, e.g. to block-select the bottom-right 3x3 cells and record them as
grassland, change the sampling mode to ‘Select grid cells manually’, and select the nine cells
using the mouse (click-and-drag):

And then click the grass button:

Manual and automatic sampling can alternated to fill out the data for the whole sampling area.
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When sampling is additionally for grid-cell dominance, the user will be prompted to enter two
records per cell; one for the cover at the point, and one for the dominant cover within the grid
cell.
Notes:
To delete an already saved record for a cell, click the manual sampling option, select the
cell(s) to delete, and press the clear button.
To show/hide the sampling grid in the zoom window, e.g. to make the pixel being sampled
more visible, toggle the ‘z’ key.
2.4.4 Data viewer form
Saved data can be viewed by selecting the Tools > Results viewer menu option, which will
display the following form:

The ‘Raw data table’ tab displays the raw saved data, which includes the saved cover type and
code (‘Grass’ with a cover code of ‘2’ in the above example. Also included are the pixel
coordinates for each of the four corners of each sample cell for all photos, and the location of
the sample point within each grid cell. These results are read from a tab-delimited text (*.txt)
file, with the same name as the project file.
The blank cells in the spreadsheet indicate data yet to be collected. In the example above the
first column (for the reference photo) has data collected, and the remaining blank columns are
for the remaining photos in the time series (photos 2-4).
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The ‘Map viewer’ tab gives a graphical summary of the saved data, and also a summary table
of the % cover of each cover class:

The above displays the location of each sampling point and its cover (colour-coded). To make
the results more obvious, point data can also be displayed as a grid:

The bottom panel of Figure 6 shows the display of results for a project where both point data
and grid-cell dominance data were collected.

28

2.4.5 Other program options
Transparent overlays
Once a project has been rectified, it is sometimes useful to overlay a transparent version of the
reference photo over the transformed target photo, and/or to be able to toggle this
transparency (see e.g. the semi-transparent overlay in Figure 3c). This allows a visual
assessment of the rectification to be made. Toggling the ‘o’ key displays a transparent overlay
of the reference photo, and toggling the ‘p’ key toggles an opaque overlay.
Keyboard short cuts
z:
Toggles the sampling point cross-hair and grid cell boundary on the zoom
image.
1..9:
Select a photo to view (1 = the reference photo; 2..9 = the target photos).
F1..F12:
Assignable keys for the cover classes. For use when sampling.
o:
Toggle a transparent overlay of the reference photo.
p:
Toggle an opaque overlay of the reference photo.
General program settings
General program settings can be found under the ‘Tools > Program settings’ menu. There are
four tabs. The first allows the selection of the algorithm used to resample thee transformed
photos. Simple linear resampling is recommended, but the other options can be explored (see
2.3.2 above).

The second tab (‘Blend method’) provides the option of changing the nature of the
transparency when the ‘o’ key is pressed to overlay the reference photo on top of a target
photo. The default method is ‘Modulate’. Also included in the list is ‘Opaque’.
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The third tab is the ‘Photo load method’. If the physical size (in MB) of all photos to be
analysed is less than the currently available system memory, then it is possible to load all of
these photo’s into memory at the start of an analysis, without the need to create the smaller
index images, as described in 2.3.1 above (select ‘Load photo’s into memory at startup’). This
improves re-drawing speed and overall performance. The default setting is to create the
smaller index images, and then to read the zoomed images from diskfile, rather than memory
(select ‘Read photo’s dynamically from diskfile’).

The final tab allows the recently used file list to be cleared:
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3. Installation and distributed files
TDT comprises a single executable file (TDT.exe), and four example projects. These files are
distributed in a single zip file (TDT.zip). To install the application, simply unzip the file to a
suitable location on your hard drive, e.g. ‘c:\program files\TDT’. The installed file structure
is:

Simply double-click on TDT.exe to run (or alternatively, paste a shortcut to this file on the
windows desktop).
Warning: The example photos that are distributed with TDT are of a low-resolution and are of
very poor quality compared with a typical scanned aerial photograph. They are provided in
this format to reduce the download overhead for distribution. Full resolution versions of these
same photos can also be downloaded from the same download location.

4. Tutorial – Time series analysis for cover change.
This step-by-step tutorial describes the process of setting up and analyzing a new project for a
time series analysis. The procedure is similar for the other analysis types (e.g. single photo,
mosaic time-step), the major difference being the storage and display of the saved results. The
tutorial example described here, and three other example projects, can also be found in the
example folders distributed with the application.
The example described here analyses cover change within the Currango area of subalpine SE
Australia. The three photographs were taken in 1944, 1963, and 1990.
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1. Start the TDT software and press
the Analysis wizard button.
On the Analysis wizard form,
select the tab (1) Add photos to
project, and then select Time
series under Analysis options.
In the Reference photo panel
click on the Add reference photo
button and load the file
‘Currango 1944.bmp’ located
within the ‘/Example Photos
(low resolution)/’ folder of the
installation.
In the Photo list panel add two
additional photos from the same
folder; ‘Currango 1963.bmp’ and
‘Currango 1990.bmp’.
The project should look like the
image on the right. You are now
ready to add the control points.
Now is a good time to save the
project (File > Save project on
the main menu).
It’s also a good idea save the
project regularly as it is being
built!
2. Click on the (2) Set control
points tab of the Analysis wizard.
This will automatically select the
reference photo for viewing.

Main window

Click and drag the Analysis
wizard form down towards the
bottom-right of the screen (by
clicking and dragging on the blue
title bar). This makes the main
and zoom windows more visible.
In the next step we are going to
add the first control point at the
location marked with this arrow.
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Zoom window

3. First move the mouse cursor over
the main window, and notice
how a zoomed view of the
current cursor position is
continuously updated in the
zoom window.

Zoom slider bar

Pass the cursor over the vicinity
of the arrowed region until you
see the drainage features shown
in the zoom window. Depending
on the resolution of your
monitor, and the dimensions of
the photo file, you may need to
change the zoom slider bar.

A

In the next step you’ll add a
control point at the position
marked ‘A’, at the intersection of
the two streams.
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4. Note: Control points are selected
within the zoom window, not the
main window. This is because
the main window displays only
the coarse-resolution index
version of the photo, but the
zoom window displays the full
resolution detail (see Section
2.3.1).
Whilst the drainage features are
visible in the zoom window, hold
down the ctrl key to lock the
zoom window and prevent it
from updating, and move the
mouse pointer from the main
image across to the zoom
window to the location marked
‘A’ in the previous step.
When the mouse is pointing to
the stream intersection, press the
right mouse button to set the
control point. It doesn’t matter if
its not on the exact location; it
can be fine-tuned later.
This action will (a) set the
control point for the reference
photo, (b) copy a snapshot of the
control point location to the
‘Analysis Wizard’ for later
reference, and (c) select the next
photo in the main window ready
for adding the next control point.
After setting the control point the
display should look like that on
the right (after moving the
Analysis wizard back to the
centre of the screen). Note the
next photo in the series is
displayed behind the Analysis
wizard, and the picture of the
control point you just set on the
reference photo is shown on the
wizard.
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5. The next step is to set the
corresponding control point at
the same location on the next
photo (‘Photo 1’ on the main
form tab).
Move the Analysis wizard back
out of the way, and again pass
the mouse over the main image
until the vicinity of the control
point is visible in the zoom
window.
Then, as before, press the ctrl
key to lock the scrolling, bring
the mouse over to the zoom
window, and add the control
point at the same stream
intersection by pressing the right
mouse key.
6. Repeat the above procedure for
the final photo, again setting the
control point for this photo at the
intersection of the same two
streams.
Note that because the example
photos distributed with TDT are
low-resolution copies of the
originals (to keep the file
distribution size manageable),
the detail is poor, and identifying
the precise locations of the
control points is, at best,
approximate. This is particularly
the case when finding this
control point for the 1990 photo,
where the re-growth has changed
the landscape considerably, and
the low resolution masks detail.
Once the location of the first
control point has been set for all
three photos in the series, their
locations are marked in both the
main and zoom windows with a
white cross, and the x- and ycoordinates of each control point
are listed in the table on the
Analysis wizard. The values in
this table indicate that the stream
intersection control point for the
reference photo (year 1944) is at
pixel location (892, 2746); for
photo 1 (year 1963) the location
is (2234, 1903); and for photo 2
(year 1990) the location of the
stream intersection is (261, 1651)
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7. Now repeat the above process
and select three more control
points in and around the cleared
area. You’ll need to scan around
the area and choose landscape
features that are common across
all time periods.
This screen shot shows the
location of a set of four control
points. The control point
illustrated in top screen capture
is for the 4th control point, on the
1990 photo. This is a good
example of an invariant
landscape feature, ideal for use
as a control point (a prominent
bend in a road)
Images of the four control points
are shown below.
The number of control points and
their location within the image is
up to the user to decide. It is
usually best to spread the control
points across the area to be
sampled, and to avoid ‘lining’
them up. Because this exercise is
only an illustration to
demonstrate how the software
works, only four control points
are used, and they are placed at
the edges of the cleared area that
will be sampled.

Control point summary

Minor adjustments to the
locations of the control points
can be made by left-mouse
clicking and dragging the white
marker cross on the zoom
window. Remember, to locate
the control point in the zoom
window first pass the mouse over
the main window image until it
appears in the zoom window,
and then press the ctrl key to
lock the scrolling, and then move
the mouse to the zoom window.

Control point 3.

Control point 1.

Control point 2.

Control point 4.

1944

1963
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1990

8. Once the control points are set
it’s now time to rectify the
photos. Click on the (3) rectify
Photos tab. Make sure Affine is
selected under Transformation
method, and press the Rectify all
photos button. The analysis will
take a few moments to complete.
After it has, the details of the
rectification will be updated in
the table.
For this example the table shows
that ‘Photo 1’ (the 1963 photo)
was rectified to the reference
photo with a mean error of 5.9
pixels (which corresponds to an
accuracy of about 7.7m, based on
independent measurement of the
photographic scale of the 1944
reference photo). Also shown is
the resulting optimized Affine
transformation matrix, and a list
of the rectified locations of each
control point.
For example the table shows
that, for the first control point,
the pixel location on the
reference photo was (892, 2746).
The same location on the 1963
photo prior to rectification was
(2234, 1093)1, and the coordinate
after rectification to the reference
photo is (889, 2749).
9. Following rectification, the
display of the photos on the main
viewing window is also updated,
with each photo transformed by
the optimized Affine parameters,
and re-drawn to overlap with the
reference photo.
Minimise the Analysis Wizard
and click on each of the photo
tabs in turn to view the results
(or alternatively, press the 1, 2
& 3 keys). Pressing the ‘o’ key
will also toggle the overlay of a
transparent image of the
reference photo.
After rectification, the white
crosses on the rectified photos
are the reference photo control
points, and the red crosses are
the control points of the currently
selected photo following
rectification.
1

Photo tabs

The unrectified coordinates are found in the table on the (2) Set control points tab.
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10. Because we want to sample the
cleared area within the control
points, make this area more
visible by centering it in the
main view window (by leftclicking on the main window and
dragging), and adjust the zoom
with the Zoom photo slider.
For setting up the sampling grid
the photo displayed is the 1990
image (Photo 2). Equivalently,
either the 1963 photo (Photo 1)
or the 1944 reference photo
could be visible for this task.

11. Its now time to set up the sample
grid. Restore the Analysis
Wizard by clicking on

and select the (4) Set up
sampling grid tab.
First edit the Data entry options
to suit the current project. The
default cover class options are
‘Tree’, ‘Grass’, ‘Shrub’ and
‘Unknown’. These can be edited
as required. For this exercise the
default options will be used.

12. Next specify the sampling
strategy, as described above in
Section 2.3.3. For this exercise
the default settings will again be
used, which record cover at
random points within a sampling
grid, and retaining the same
random point locations for each
photo.
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13. Next define the measurement
units and grid resolution. For this
project, because we know (from
independent measurement) that 1
pixel = 1.13m, we can use metres
as the measurement unit (rather
than units of image pixels, which
are somewhat arbitrary).
Enter the pixel resolution (1.13)
in the box, and select Metres
under Grid units.
The sampling grid will have a
resolution of 50m x 50m grid
cells. Therefore change the
Sample grid cell size value using
the slider to ‘50’. The rest of the
settings can stay as they are.
14. Press the Create new sampling
grid button, and move the
Analysis wizard off to the side to
clear some space.
The initial grid is displayed. It
shows the boundaries of the grid
cells (in red) and the locations of
each sampling point within each
grid cell (white cross).
The initial grid covers the entire
visible area and is oriented
North-South.

15. To change the orientation, adjust
the Rotate Sampling Grid setting.
Rotate the grid by adjusting the
slider until it is approximately
orientated with the cleared area
(-29 degrees in the example
here).
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16. Because this is just an example,
we will sample only a small area,
just to get the feel for how the
software works.
To select a sub-area for analysis
click the Select sub area for
analysis button. The button will
turn yellow. Now click on the
top-left cell of the desired
sampling area on the main
window, and select a 15x15 grid
cell (or thereabouts) sampling
area (=750m x 750m). click ‘yes’
to accept the selection.

The final sample area will now
be displayed.

17. Its now time to collect some
data. In this example the first
photo to be sampled is the 1990
image, though it could
equivalently have been the 1963
or 1944 photo – the choice of
starting photo is arbitrary. Press
the Start photo sampling button
on the Analysis wizard. This will
display the sampling form.
The first thing to do is decide
whether you are going to let the
software guide you through the
sampling, prompting you to enter
data when necessary, or whether
you will enter manually.
To get started click on the Select
grid cells automatically option.
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18. Selecting ‘automatic’ will result
in the first grid cell to be
sampled to be highlighted in
blue.
It will also automatically display
the contents of the first grid cell
to be sampled in the zoom
window.
Using the image in the zoom
zoom window, make a visual
determination of the cover at this
first point (the white cross). To
clear/view the cross in the zoom
window toggle the ‘z’ key.
Because of the low resolution of
the example images distributed
with TDT it can be a little
difficult to determine the cover
accurately. For the purposes of
the exercise the point illustrated
is assumed to be ‘tree’, so the red
‘Tree’ button will be pressed (or
the appropriate F1-F2 key; see
Section 2.4.2).
19. Pressing the ‘Tree’ button puts a
red marker on the main image to
indicate that the cell has been
sampled, and what cover class it
is.
The next cell to be sampled is
then highlighted in blue, and its
contents are automatically
displayed in the zoom window.
For this next cell the sampling
cross appears to be over
grassland, so the ‘Grass’ key is
pressed.
Sampling continues in this way,
with TDT guiding the user
through the sampling area, and
automatically displaying the next
sampling point in the zoom
window as each data entry is
made.
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20. In this figure the first three rows
of data, sampled using the
automatic setting, are shown.

21. To sample manually, click on
the Select grid cells manually’
option.
There is a group of 8 cells in the
densest part of the woodland that
can be batch-selected and
entered as ‘Tree’ using a single
mouse click. To do this simply
either select single cells in the
main window by clicking on
each of them individually (or by
clicking and dragging to ‘paint’
an entire area). Your selection
will be highlighted in blue.
Combinations of single-cell
clicking and painting can be used
to select non-contiguous areas.
Once you have selected all the
cells you want to, click on the
‘Tree’ button and the cover of all
of those selected cells will be
recorded.
You can either carry on selecting
cells and entering data manually,
or switch back to automatic
sampling, or alternate between
the two.
To delete a previously saved cell,
go to manual sampling, select the
cell(s) to be changed, and press
the clear button.
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22. The completed sample area for
1990.

23. To sample the next photo, just
select it on the main tab, and
continue as described above.
You can adjust the zoom window
slider bar to get the optimal
zoom factor, and you can move
the Sampling form out of the way
to reveal the second zoom
window, if required.
The completed sampling for the
1963 and 1944 photos is shown.
Here.
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24. To display the saved data, close
the sampling form, and open the
Tools > Results viewer from the
main menu.
The Raw data tab displays the
raw data that has been saved, as
described in Section 2.4.4 above.
This is a tab-delimited text file
with the name
ProjectFilename.txt.
The Map viewer tab shows a
graphical summary of the saved
data.
The maps on this page show the
locations of each sampling point
within the sampling area for each
year, colour-coded to show the
recorded cover type.
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24. To make the results more
visually obvious, it is possible to
alternatively display the point
cover data as a grid, as shown
here.
The cover maps for the three
years in this project graphically
illustrate the steady increase in
woody cover within the sampled
area over the period 1944 to
1990. (an estimated 11% woody
cover in 1944; 32% in 1963; and
68% in 1990).
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